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Introduction 

Thank you for choosing WINLIVE by Promusicsoftware, the first musical repertoire management 
program with specific Karaoke features, whose first version dates back to  November 6th, 1994. 
The intention of its founder, Leonardo Di Pinto was to create a program that could work with 
different file formats then to manage them in a simple and immediate way. WINLIVE HOME 
SYNTH 11 version, available for both Mac OSx and Windows, is designed for a professional use. 
Thanks to its last update, it is particularly appreciated by singer-performers, who require a reliable 
program to manage their own musical repertoire, compatible and adaptable to their proper tools 
in order to look like being on stage.   
Karaoke enthusiasts, who like to customize their performances, also appreciate it very much. 
HOME SYNTH is WINLIVE’s commercial version, therefore third parts assignment, unlawful copy of 
the license and any other copyright piracy action concerning the software are forbidden. 
Reverse Engineering implementation, code and graphic resources editing as well as reproducing all 
files even partially are forbidden and open to legal prosecution. We decline any responsibility from 
using the software improperly and/or damaging the operating system as well as losing data. 

  
To know more, visit our website: 

 www.promusicsoftware.com 

 

WINLIVE is a Pro Music Software brand 
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INSTALLATION AND REQUIREMENTS 
To install WINLIVE just run the setup and then follow the instructions on the screen. Normally, at 
the end of the installation, the software requires the entry of your PERSONAL ACCOUNT and the 
SERIAL NUMBER, which can be found in your e-mail (if the software was bought online) or in the 
package of the software (if bought in store). You can choose the demonstrative mode, in case you 
do not have the license, in order to discover all Winlive features. DEMO version has a limited use 
(it can only manage 20 songs) and its public use is expressly prohibited. FULL version has no 
restrictions.  
Internet connection is necessary to activate the software. When the computer is connected to the 
internet, you can simply entry PERSONAL ACCOUNT, SERIAL NUMBER, and all required data. 
When an ID COMPUTER appear, you just need to click on ACTIVATE YOUR COPY HERE. 
 If your computer is not connected to the internet, you should install software setup, then insert 
PERSONAL ACCOUNT, SERIAL NUMBER, and all required data. At this point, an ID COMPUTER will 
appear. From any device connected to the internet, connect to our website: 
www.promusicsoftware.com 
Go to Activations insert PERSONAL ACCOUNT and SERIAL NUMBER to log in your personal 
account. Click on NEW ACTIVATION, so insert the ID COMPUTER generated by the program. Then 
a license number will appear. Copy it and paste it in the blank line as required by the program. 
 

A YOUTUBE SERVICE is provided with the software. 

In all cases, assistance by email and telephone is guaranteed. 
 
 

Watch the video tutorial to learn more about the installation of the software 

https://youtu.be/KY4lNKBAdAk 

 

* System requirements recommended for Windows: Ram 2Gb, 200 Mb Free space on Hard Drive, CPU i3 or better 
* System requirements recommended for Mac: Ram 3Gb, 1200 Mb Free space on Hard Drive, CPU i3 or better 

* Compatible with Windows 7, Windows 8/8.1 and Windows 10, 32 bit or 64 bit 
* Compatible with Mac osX (tested from High Sierra to Big Sur) 

 

Note: the recommended system requirements grant the functioning of the software and the execution of the songs by 
the program but it could be necessary to deactivate all graphic effects to get a better performance, which could 
decline substantially during the reproduction of CDG or VIDEO files. 

The software could work with older versions of Windows but correct functioning is not granted. 
* Without the recommended system requirements, starting the program could result slower due to the swapping on 
the HD and the slowness of the processor. 
* Some antivirus could slower the initiation of the program. If the software stucks on start on “Check Antivirus” for a 
long time, deactivate the antivirus temporarily.  
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Functionalities 

WINLIVE HOME SYNTH is not just a Karaoke software but also a feature-rich music player and 
management program. WINLIVE HOME SYNTH provides a real-time playback management. 
Synchronized lyrics and chords contained in the files are easy to see and read. It is also possible to 
synchronize lyrics and chords on empty files or on files that do not provide them at first. WINLIVE 
HOME SYNTH manages up to 42 playlists, named SONGLIST, of which 39 in Database, 1 temporary 
(F10) and 2 Song Folder List (F11 and F12 for external loadings outside of the database). It is 
possible to act on different parameters of a music file: you can start and stop it at any time, 
change the rhythm, the tone (any format audio and video), the instruments, the volume, the pan, 
etc.… till the single drum notes, everything in real time! 
Great improvement in the listening of Midifiles is provided by our Synthesizer software (Winlive 
Synth Orchestra) included in the program aiming to get obtain a real sound. 
 

We recommend to our users not to use illegal copies of the software, reminding 
not only that holding software without any number of registration is a criminal 
offence, but also that the same pirate software contain dangerous virus that can 
cause system crash.  
Main features of WINLIVE HOME SYNTH 11 
(in bold the novelties compared to the previous version) 
 
Player section 
* Playback multimedia files(midi, kar, mp3, mp3+lrc, wav, cdg, cdg-zip, wmt, avi, mpg, mp4, flv, wma, lrc, txt, rtf, 
jpg, gif, bmp, ytb youtube, pdf) 
* Read WMT (Winlive Multi Track) multitrack audio files up to 16 tracks including any txt and pdf files 
* Key change management for Midi, Audio, Multitrack Audio and Video files 
* Support for dual monitors (karaoke monitors) also for video and cdg files 
Scrolling text (for Windows version only) 
* New graphics, new icons and innovative functions that can be called directly with the buttons 
Images as moving background can also be called at random from an image folder. 

* New sound library (for Synth version only) 
* Accelerated database management 
Ability to zoom PDF files for proper display on the monitor 
Youtube functions with forward/reverse controls / stop etc.. 
Audio mixing even with video files 
Import of Vanbasco playlists with tonality parameters, mute channels, etc.. 
Winlive Dj Control with BMP recognition for audio files with real-time effects 
Metrodrummer ( electronic drums with preset rhythms ) 
Midi remix styled using a library with more than 250 rhythms 
* New available rhythms  
Ability to easily replace the rhythm of a midifile and save it in database 
Audio Recording on Midi and Audio 
Advanced mixing editor with max 5 different patterns that can be called in real time 
Instant booking with fade out or mixing between song Audio and Midi 
Melody preview bar 
Built-in video codec repair/installation function 
Automatically search orphaned files in PC folders and subfolders 
Orphan highlighting (missing file) already in the songlist 



 

 4

Audio Samples editor to insert up to 100 samples in real time 
Virtual storage of file changes 
Text import in TXT, RTF, PDF format (electronic readout mode) 
Portrait (vertical) tablet support for windows 
Various karaoke display methods 
Assign the melody to any midi channel (default midi channel 4) 
Possibility to associate a text, a pdf or an image to an Audio or Midi track 
Compatible with Songservice karaoke format (M-live) 
Extraction and conversion from Cd to mp3 or wave 
Performance 'Quick icons' buttons for instant access to various sections 
Inserting images as background 
Cover function to vary the feeling of the midifiles 
Notes display on piano keyboard for educational use 
* Dozens of new features suggested by our users 
* Youtube feature renewal only available for WINLIVE 11 series versions *** (see annotations) 
Intituivo, functional and performing 
Section SYNTH (PLUG INS SYNTH) 
New high-quality 96 MB GS/GM+ internal sound bench 
96 MB Wavetable composed of 32 Drumkits and 344 Instrumental Sounds 
New increasingly performing sounds to increase the quality of your midifiles 
Possibility to import personal benches SF2 
 
 
 
It is recommended, however, to upload the latest version to keep ‘’up’’ with the continuous innovations of Winlive.  

Main features of WINLIVE HOME SYNTH 11 
(The ones in bold are the new features compared to the previous version) 

 
 
SYNTH section (SYNTH ORCHESTRA) 
* New Internal GS/GM+ sound bank of 96 MB HI-Quality Wavetable (SFX sounds included) 
* Wavetable with 32 drum kits and 344 sounds  
* New and more and more performing sounds to increase the quality of your midifiles 
Implementation of low latency WASAPI drivers 
It is possible with low latency to play a midi keyboard directly linked to your computer 
Winlive digital piano, up to 4 part sound synthesizer 
ASIO Driver management 
Convert MIDI to Wave or Mp3 directly with karaoke and chords included 
Main volume, Compressor, filter enhancer on Midi Engine 
Delay effect management on every midi track 
Multi effect management on sounds from inner Synth with more than 20 selectable MFX on every midi track 
 
* Notes for Mac version: some functions on Mac computer may change or not exist compared with PC 
Windows version (mainly Scrolling text, combination of effects to sounds, YouTube tracks execution external to 
program) 
 

After the purchase, automatically, you will receive via email the activation codes.  
You can use up to 3 activations per license even on different computers 
For further activations please contact Promusicsoftware 

Note: if you replace or format the hard disk, an activation is lost 
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File 

Info: WINLIVE can perform its songs in various ways. 

1) We can play one or more songs by dragging them directly to the Performance screen. In this 
way, by dragging a single file we could listen immediately while for multiple songs a temporary 
Songlist will be created and then selecting the favorite song we could play it by pressing the enter 
key. 

2) We can load a single song from File menu and then Load File 

4) The last way to perform our songs is to use the Database. This mode has made the Winlive 
famous all over the world and is mainly used by musicians, singers and bands. With this mode it is 
possible to save the many options that Winlive offers  (see Database paragraph); 
 
MULTI IMPORT IN DATABASE 
You can select the various songs to be imported into the Database (see Database paragraph); 
 
LOAD FILE 
It is possible to load a single song and play it immediately. 

 

 
FOLDER 
Here you can load an entire folder of songs and associate it with special songlists that can be 
recalled with the F11 and F12 keys. This function is very useful, for example, when we want to 
view the contents of a USB key without loading it into our database 

 

https://youtu.be/QoXKFH65T30?t=235 

 
LOAD LIST F10 
By clicking on this item it is possible to load those lists created in the temporary lists and recalled 
with the F10 key. Remember that the temporary lists are emptied every time you exit the 
program. 
 
SAVE LIST F10 
Here you can save temporary lists. 
 
IMPORT IN DATABASE 
If a song is loaded temporarily it is possible with this function to import it into the Database. 
 
IMPORT IN DATABASE ALL F10 
With this function it is possible to import an entire temporary F10 songlist into the database. 
 
STOP AT THE END OF EACH SONG (Performance) 
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This parameter sets the STOP at the end of the song even if a song has been booked 
 
STOP OF THE SONG EVEN IF BOOKED 
This parameter sets the STOP at the end of the song even if a song has been booked 
 
RANDOM NEXT SONG (Performance) 
It is possible to set a random execution of the songs of the current songlist 
 
MLIVE ENCODING PRECEDENCE INSTEAD OF KARAOKE 
Very often in a song there may be several lyrics, perhaps created with different programs. 
Enabling this function gives priority to the display of the MLIVE lyrics. MLIVE encoding is present in 
songservice songs 
 
AUTOMATICALLY LOCK THE KEYBOARD 
With this option the PC keyboard is locked. This function is very useful when you are away from 
the PC so as to avoid that someone touching the keyboard can compromise our performance 
 
MINIMIZE 
The WINLIVE program is minimized to display the PC desktop 
 
CLOSE 
The program closes. In this case some parameters and the database are automatically saved 
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View mode 

Through the menu View Mode, it is possible to choose the program’s operating mode: 
Performance [CTRL+ALT+P]: it is the playback mode used to control the various Song-List playlists 
on startup, as well as the disposal of the song booking, the control the performance, mixer and 
karaoke (see paragraph);  
Visual Mixer [CTRL+X]: displays a mixer horizontally with which we can control the various tracks 
of the midifiles or of the audio multitrack songs 

 
Database [CTRL+ALT+D]: it the collection of songs, used to organize and catalogue them; 
The database stores the path of songs, their parameters, their changes and the insertion of any 
images as background, texts or pdf combined to every song (see paragraph); 
Metrodrummer [CTRL+ALT+B]:  electronic drum with more than 220 pre-set rhythms with the 
chance to sync with midifiles or like a real desk electronic drum (see paragraph); 
Winlive DJ Control [CTRL+ALT+J]: section with typical Djs mode with BPM recognition for Audio 
files, effects in real time and several tools available (see paragraph); 
YouTube Songs [CTRL+ALT+Y]: section where it is allowed to search for video files directly on 
YouTube and eventually include them on your SongList (comply with the terms of use of YouTube). 
This mode requires an internet connection (see paragraph); 
YouTube SongList [CTRL+ALT+L]: is a weekly uploaded section of links to YouTube tracks. An 
internet connection is required, as well as the acceptance of YouTube conditions (see paragraph); 
 
 
KARAOKE MONITOR 
You can activate the second monitor (karaoke monitor) by clicking on the menu "View" -> 
"Karaoke Monitor" or  [CTRL+K] from the keyboard. 
A second Winlive window will open, which you can drag on the second monitor; double clicking on 
it will be set to full screen. 
By right clicking on the main monitor screen you can change the character and mode of the 
Karaoke Monitor, you can choose between: 
• Multiline scrolling karaoke (only Microsoft Windows); 
• Winlive Classic: 2 lines; 
• Modern Style: 4 lines; 
• Music Stand: 4 lines + 1; 
• Karaoke Zoom mode 
• No Karaoke 
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Note: to make this function work correctly, from Windows imports, select the second monitor in 
Extended Desktop mode. Refer to the video card help manual. 

 
 
 
 
 
SAMPLE PLAYER 

By pressing the button  you can access the Sample Player or by pressing the [S] key 

 
 
With this function, it is possible to reproduce quickly, even during the execution of a song, sound 
effects, images, pdf, texts or Audio Loops. 
It is possible to have 10 Banks of 10 Samples each, for a total of 100 samples. 
To upload the samples, click on the box next to each sample (when no sample is loaded, “No file 
Loaded” appears) and choose the file from the dialog. 
For each sample, you can adjust the volume. You can play the samples in Polyphony, or, by 
checking the Mono option, play them in Monophony (i.e. if one sample is running, and another is 
recalled, the running sample is terminated). 
The Comp option allows, if checked, to activate a general compressor on the samples, that 
automatically uniforms their volume. 
During the Performance, it is possible to access the sampler just pressing the [S] key, and then 
pressing keys [1] to [0] on the keyboard. To stop the reproduction of the samples in a forced way, 
press the [\] key. 
It is possible to download additional audio samples by clicking on Download Samples 
 
 
Piano Key [CTRL+H] 
By clicking on this function, a piano keyboard is shown on the screen where the notes 
corresponding to the midi track will be displayed. 
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Obviously this function is only available for midifiles. 
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NOTEPAD WINDOWS 
It allows you to view a small Notepad in various formats where you can write notes during your 
performances. By clicking on CLS you can delete the entire contents of the Notepad. 
 

 
It is selected by View ModeNotepad Windows [CTRL+N] 
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Tools 

OPTIONS 
In this function and in the submenus you can customize the program according to your needs. We 
remind you that WINLIVE, leader in its category for more than 27 years, has collected the requests 
and listened to the needs of thousands of musicians and singers all over the world so as to be able 
to adapt the program in a personalized way. (see paragraph) 
 
SONGLIST EDITOR 
You can access the SongList Editor by the Tools menu  Editor  Song list editor or by clicking on 
the bottom left next to the name of the SongList. 

 
 
In order from the left we will find: 
- the corresponding key to recall the Songlist; 
- the number of songs in each Songlist: 
- the name of the Songlists 
- by ticking the STOP box, the set list will stop playing, while not ticking it allows continuous play; 
- by ticking the MELODY box, each song in the list will be played without the melodic guide 
(midifile); 
- the ORDER function provides a drop-down menu from which you can select the order mode in 
which songs will be played (if we indicate TITLE, for example, we will have an alphabetical order, 
rather than by ID, by interpreter, by author and so on). 
DEFAULT ORDER: here we can select a general order as long as there is no specific order in the 
SongList. 

https://youtu.be/y5E5pEAKWag 
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EDITOR->MIXING EDITOR 
Mixing Editor can be accessed via "Tools" menu Editor 

 

With the mixing editor, you can set the progress and duration (in milliseconds) of the Cross-Fade, 
i.e. the mixing of two songs. We remind you that mixing between 2 midifiles is not possible. In this 
case we will pass from the first to the second song, by fade out and not mixing 

The green line indicates the ending song, while the red line indicates the song that will be merged 
together with the first one. 

By default, Winlive will adopt a linear type behaviour, with a progressive and constant lowering of 
the volume of the song to fade, simultaneously with a progressive and constant increase of the 
volume of the following one. You can select five pre-set curves, or draw a custom curve. 
 
EDITOR->QUICK ICONS 
 

 
In the right part of the bar you can see several coloured buttons which allow the quick access to 
several functions and modes:: 
(We remind that these quick buttons may not be viewed if the resolution of the monitor isn’t right 
as for notebook with little monitors)  

 PRF: Quick button to come back to Performance mode 

 MDR: Quick button to enter in Metrodrummer (Virtual Drum Machine)  

 WDJ: Quick button for the access to Winlive DJ Control 

 CDP: Quick button for the access to CD Player 

 KMN: Access to Karaoke Monitor 

 DBS: Access to Database 
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 PNO: Opening Piano Key Board 
It is possible to edit Quick Icons and to assign to everyone some specific functions 
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UTILITY -> FILE TRANSFER 
By clicking on this item we can transfer all the data present from the c: \ Program Files folder to 
the Documents folder thus obtaining unrestricted access. 
 
UTILITY -> OPEN FOLDER WINLIVE DOCUMENTS 
This utility will allow us to locate and directly open the Documents folder where Winlive files will 
be present. 
 
UTILITY -> OPEN VIRTUAL FOLDERS AND STORE 
Windows creates hidden folders where Winlive in previous versions stored important files such as 
the database. To access these particular folders directly click on this function.. 

 

UTILITY -> START WINLIVE CD PLAYER / EXTRACT 

 
 
With this function, it is possible to extract tracks from Audio CDs and save them in Wav or Mp3 
format. 
It is necessary to select them (you can select them all through the "All" button or select them 
manually by clicking on the first column), then click on the Convert button. 
You can choose between uncompressed Wav (Wave not compressed) and Mp3, varying the 
quality according to your needs (eg "Minimal Only for voice store" generates a low quality file with 
the smallest footprint on disk, while "Maximum quality” generates a high quality file, but also with 
the largest disk size). 
 
The peculiarity of this CD player is that it has the advanced features of commercial DJ CD 
players, that is, it allows you to change the tempo and intonation (Key) in real-time. 
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UTILITY-> GUITAR TUNER 
The guitar tuner could not be missing to make happy guitarists and other musicians.  

 
We can choose the tuner sound, the length of the sound (sustain), the dynamics (Dyn) and the 
Transpose. 
 
 
GUIDE 
The manuals and audio and video media for the program are displayed 
 
 
SUPPORT 
The current version of the program is displayed. The personal account, serial number and related 
license. It is also possible to log into your account on the Promusicsoftware website. 
 
REPAIR / INSTALL VIDEO CODEC 
It can rarely happen that, especially due to Windows updates, video files are not played properly 
(no sound or no video). This feature allows us to restore everything. For example, if we launch a 
video and we do not hear the audio, we can click on the following function then OPEN FOLDER and 
finally launch the K-Lite_Codec_Pack_1205_Basic file. Continue until you install the codec package. 
At the end of the installation we will hear the missing audio 
 
UPDATES 

This function will allow us to verify that there are new updates to the 
program, free or paid
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Performance mode 

Below is the ‘’Performance’’ screen of WINLIVE HOME SYNTH 11 
 

 
 
 
The SongList 

The SongList is the ‘’heart of the program’’ accessible through function Keys or  
The name of the song will be showed in the grid (as set in the database) as well as the typology, so 
the file format, indicated by a specific colour. 
The songs with lyrics are distinguished by the icon . 
The cursor buttons (the 4 arrows) of the keyboard can be used to select the files. 
There are a total of 39 SongLists (or playlists) that can be called with buttons: 

 For Windows 

 from F1 to F9 (from playlist 1 to 9)  

 Shift + [ from F1 to F10 ] (from playlist 11 to 20)  

 Ctrl + [ from F1 to F10 ] (from playlist 21 to 30) 

 Shift + Ctrl + [ from F1 to F10 ] (from playlist 31 to 40) 
 

 For Mac 

 Push the button ‘’?’’ and type the playlist number (from playlist 1 to 40)  
 
In addition, it is possible to set special SongLists: 
- F10 (temporary SongList) it is possible to add songs from other SongLists by pressing the button 
‘INS’ or clicking the right mouse button then ‘add to F10’ 
- F11, F12 (song folder list) it is possible to add all files of a folder to one of the two lists, to set a 

folder push from keyboard ‘\’ or  
The combination of buttons Shift + F11 or Shift + F12 of the keyboard allows you to view the 
whole database in a single SongList 
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The button BACKSPACE or  opens the research bar (picture below) 
 

 
The research can be done on the single SongList or on everyone else (putting the check on ‘’All The 
SongLists’’) 
It is possible to scroll the results through the button “TAB” of the keyboard, for example a 
research of ‘’HELLO’’ will give you results such as ‘’HELLO DOLLY’’, ‘’I SAY HELLO’’, and so on. 
If the author and the artist are set in the database, we can filter the playlist viewing only the 
results related to certain authors or artists. To view the playlist another time, you just need to click 
on ‘’ALL’’. It is now possible to do a research in the whole database simply pushing buttons “Shift + 
F11” or “Shift + F12” from keyboard, which allows you to view all the results.  
From drop-down menu, we can select the typology of file to search for (midi, audio, video). 
Furthermore, it is possible to view and filter the songs according to certain features: for example, 
if we type the word ‘’WAY’’ then pressing the button ‘’TITLE’’, you could see only the songs that 
contain the word ‘’WAY’’. 
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POPUP MENU 

 
Clicking on right button of the mouse, on the main screen of Winlive it is possible to open a Popup 
Menu, from which you can have access to different functionalities: 
 

 Load File: read files quickly without inserting them in the database; 

 Events managment: Enable the Events Window feature to associate events with midi and 
audio files. This function generates an associated file with the extension * .wen 

 Set Folder: quick access to SongFolder List (F11 and F12); 

 Fullscreen: full screen view of the main screen; 

 Normal: restore the view with menu and control bar;  

 Minimize: the picture of Performane is closed as icon; 

 Window size: allows to reduce the window dimensions; 

 Karaoke mode: allows to choose the different modes: Multiline scrolling karaoke, Classic (2 
lines), Modern Style (4 lines), Music stand Mode, Music stand with chords, Music stand 6 lines, 2  
lines at the top (musician style) or no karaoke; 

 Enlarge Font: allows to enlarge the font dimension; 

 Reduce Font : allows to reduce the font dimension; 

 Font: allows to change font type, style and dimensions; 

 Use background image: displays or removes the background image; 

 Monitor Background: allows you to load an image as background 

 Karaoke Monitor: allows to enable the second screen (see dedicated section); 

 Karaoke Monitor mode: allows to choose the view mode of the monitor and the dimension  

 Lock keyboard (CTRL+S): choosing this function the buttons are disabled; pushing a function 
button the keyboard restarts working; 

 Stop-Panic: stops the playback of the files and re-initialises any expander; 

 Import into database: import a song directly into the database. 

 YouTube start: set a starting point of the song connected to YouTube 
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CONTROL BAR 

 

 
 
The CONTROL BAR is divided into 4 parts, the left part (transport bar) is  reserved to control 
buttons of the song, the second part is related to the song which is playing at the moment (Main 
Song), the third part to the song which has been booked (next song). 
The fourth part is composed of a series of buttons, quick to access to different functions and mode 
QUICK ICONS (these quick buttons may not be viewed if the monitor resolution doesn’t allow it: 
for example netbook or notebook with low resolution screen)  
 
Through the buttons placed in the bar below it is possible to control: 
Melody channel (on or off) for the midis; 
The tempo in BPM compared to the original tempo for midifiles; 
The key change for midi, audio and video files.  
Once the time and the custom tone are set (also for volume and other parameters which can be 
checked from Mixer- see dedicated section), it is possible to save these parameters virtually in the 

database, pushing the button  placed up. So, every time you will launch the edit file, this will 
be performed with all the made changes and the modified parameters will be conserved also after 
quitting the program.  
 
MIXER 
To select the midi channels or manage the audio it is necessary to open the mixer (key 'X') or click 

on . 
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The Mixer window located on the left side of the "Performance" screen allows you to keep under 
control various parameters both midi and audio. 

 

 

Click on an item to open a drop-down menu and 
make a choice, including enabling / disabling the 
track, soloing it or activating them all. It is also 
possible to go into the detail of the track, apply an 
MFX effect, select Drum Editing and User Sound 
Editing (see detail). 

In red the muted channels in white the active ones. 

You can enable / disable a metronome by clicking on 
the corresponding button. 

The Comp key activates and deactivates the 
compression of the dynamics of midi files. 

Through the Device column it is possible to select a 
different Midi output for each individual channel. You 
can apply these Device settings for all songs by 
clicking on the Lock button. 

Through the Remix Style it is possible to change the 
style of the song, choosing between the various styles 
and being able to apply 2 types of variation and the 
use of percussion, the intro and the end of the style. 
This is obviously valid only for midi file;; 

In the Audio section we find the Volume Fader to 
adjust the level of the output audio, the three faders 
for equalizing the sound; Gain adjusts the gain of the 
audio backing track; the V.Att fader regulates the 
attenuation of the voice. The Master Track Effects 
faders (A - B) adjust the volume of the effects 
selected in the drop-down menu in the 
corresponding box; 

Pan and right and left channel management for MPX 
files 
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Virtual save allows you to store the change in the database. 

In the mixer section we also find the management of MPX files. In this mode you can manage and 
save the left or right channel of the audio file. 

 
 
VIRTUAL KEYBOARD 

Enabled by pressing the button  at the top right of the video in Performance mode, Virtual 
Keyboard allows you to activate this screen as shown in the photo below: 

 
 
It allows you to use the basic commands if we use WINLIVE on TABLET WINDOWS or touch screen. 
The F1 / F9, Shift F1 / F10, Ctrl F1 / F10, Shift + Ctrl F1 / F10 keys are used to select the SongLists; 
Esc closes the list; 
the left and right arrows scroll the list in the commanded direction; 
the + F10 and - F10 keys remove or add songs in the provisional list F10; 
Start, allows you to start playing the selected song; 
Mix, allows mixing between one song and the next; 
the X button closes this screen. 
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AUDIO TRACK RECORDING 
This function allows you to record an audio track on a song included in the database  

Start a song and press the record key:  
 

 
 
From the panel you can select the Audio device, Line and input Volume that has a signal 
adjustment fader. The Filename indicates the saving path of the recorded track, but it is possible 
to change it by typing the appropriate key. 
WAV Format indicates the standard format for saving the track, but this can also be changed.  
By clicking on "Start Test" you can perform a recording test by checking the incoming volume level. 
At the end of the test, the button "Stop test" allows you to return to the initial condition. 
The "Start record" and "Stop" buttons are used respectively to start and end recording tracks. 
The recorded track will be associated with the song in database in the MEDIA column and in 
performance a "2nd track" window will appear next to the song title with a small vertical cursor 
that represents the volume of the recorded track. 

 

Note: at the moment this function is not enabled on Mac OSx 
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Database 

Below is the "Database" grid of Winlive Home 

 
 
- Create, Open and Save 
From Performance it is possible to access the database by clicking on the menu at the top 
Database -> Database or from View mode -> Database or by clicking the quick button (quick 
icons) DBS 
It can be accessed without using the mouse by pressing the CTRL + ALT + D keys 
WINLIVE HOME 11 allows you to manage multiple databases. 

 To create a new database press the button:   
Winlive will ask whether to save the already present database, after which it will empty the 
current database. 

 To open an existing database press the button:  
Winlive will ask you to specify the name of the database to open. 

 To save the current database with a name press:  
Winlive will ask you to specify the name of the database to save. 

 To import a database created with versions 5.5 / 4.5 / 4.6 / 4.7 / 5.0 / 5.5 press:  
Winlive will ask you to specify the name of the database to be imported. 

 To make a backup of the database press:  

 To restore the previously created backup press the button:  
Winlive will show the backup date and time. 
 
Warning: creating a new database, or restoring a backup, will delete the one previously created if 
you do not save it. 
- Edit the cells 
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You can change the cells values by double clicking on each cell if you are in "Selection" mode or by 
pressing the "E" key. You just need a single click when in "Edit" mode. 
On some fields the entry process will be guided, on others it is possible to write directly inside, 
other fields are informative and it will not be possible to edit them, for example Type field, ID... 
 
It is possible to edit some values quickly through the "Preview" window that allows you to listen 
quickly to a preview with new settings applied. 

Right clicking on a cell (or on a selection of cells) allows you to access a menu through 
which you can perform various operations: 
- Select all: highlight all songs 
- Reset selection: cancels the selection of the tracks 
- Copy: copy 
- Edit: edit the selected cell 
- Multi field insertion: allows a multiple selection on several songs at the same time. 
- Sort A-Z: sort in ascending order in the selected column 
- Sort Z-A: sort in descending order in the selected column 
- Delete database: delete the song from the database but not physically from the hard disk 
- Sort grouped by SongList: sorting in ascending order according to the SongList 
- Get interpreter / author from folder name: the folder name is displayed in the Artist  
column. 
- Move to List: move the selected songs from one SongList to another 
- Copy to List: copy the selected songs to a SongList 
- Restore files-Path (scanning): this important function allows you to restore the path if the 
files have been physically moved from one folder to another. It is also possible to restore 
the path for the files of the MEDIA and TEXTFILES columns 
- Replace part of the path: replaces a complete route or part of it with a different one. For 
example if I physically moved some songs from the folder C: \ SONGS in D: \ MY SONGS I 
have to select the interested songs and write as in the picture 

 
- Mute channels: to select the channels to be muted 
- Copy IN: physically copies the songs from one folder to another with the possibility of 

updating the paths in the database 
- Move IN: physically move the songs from one folder to another with the possibility of 

updating the paths in the database 
 
- Multi-selection 
If you hold down the CTRL key, you can select multiple songs in order to operate in groups. 
If you are in "Selection" mode, the song is deselected by clicking on it, while in "Edit" mode just 
click on any field to deselect everything. 
 
- Database columns 
Below is the sequence the columns of the database 
ID: indicates the number in chronological progression of the imported songs 
SongList: the belonging SongList is displayed 
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Title: indicates the title of the song 
Artist: performer of the piece (artist) 
Author: author of the piece.  
Genre_Notes: we can enter the genre of the song or annotations on the song itself 
Type: value not editable. Indicates the type of file (mid, mp3, video, etc.) 
Karaoke: value not editable. Indicates the presence of the text within the file. It is valid only for 
midi files and mp3s 
Tempo: value not editable. It is the time relative to the song 
TempoP: it is the edited time 
ChOff: indicates muted channels for midifiles 
Transpose: displays the changed pitch 
Volume: the standard volume of the song (100 means volume as in the original) 
Media: file associated with the song (for example associating a pdf, an image, a sound, etc.) 
Textfile: Text associated with the song (txt or rtf) 
Order: allows you to create a custom order of the songs in the set list 
When we want to create a custom order, we have to insert a series of numbers in order to create 
a numerical criterion 
For example if we want to create a playlist with this personalized sequence 
IMAGINE - YESTERDAY - MICHELLE - LET IT BE 
We will insert these numbers for example: IMAGINE (15) - YESTERDAY (21) - MICHELLE (50) - LET IT 
BE (88). No matter what numbers we enter, the important thing is to create an increasing number 
sequence 
After doing this, remember to assign this sorting order to this SongList in SONGLIST EDITOR 

https://youtu.be/y5E5pEAKWag 
Key: indicates the key of the song 
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-Import of the songs 
Start entering some songs by clicking on the left side of the database called Explorer. 
Select a folder and open it with a double click. The songs contained in the folder in question will 
appear. If the folder is located on the desktop or in Docs folder, we can view them simply by 

clicking the buttons  
 
We can select a song, several songs (by holding down the CTRL key) or all the songs in the folder 

by pressing the button  

By clicking on  , the selected files are imported. 
 

 
 
Now you can select: 
• The destination SongList; 
• Copy TO: a secondary folder where to save the copies of the imported files; 
• MOVE: the selected files are physically moved to another folder 
• The mute channels for Midi files; 
• Use file name as title: displays the name of the file as the title of the song (Title column) instead 
of the title that is usually included in the file itself; 
• Quick import: speeds up the import by ignoring some information; 
• Do not import if it already exists in the database: avoid uploading files down in the database; 
• Write Interpreter as folder name: write the artist of the piece (Artist column) by taking 
information from the last folder that contained the above mentioned song. 
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Note: fast import performs the process extremely quickly but does not allow thorough checks on 
the integrity of the file and the MP3 tags. 
 
In any case, files that are deemed invalid, such as Midi that have notes jammed or lacking vital 
information will not be imported in order not to compromise any user performance. 
In any case, at the end of the import a short report will appear about the imported and invalid 
files. 
 
Attention: the integrity checks will not be provided on the files of the Song Folder Lists and on the 
files launched with Load File 
 

 
Set filters on the display based on the type of File and / or the SongList to 

which it belongs 

 

 

 

In the order: 
- Return to Performance mode 
- Import songs 
- Delete current song 
-  Delete all the songs now shown in the grid even if not selected 
- Use file name as title for the selected song 
- Search for a title among the songs on the grid 
- Missing files 
- Import the Playlists of Vanbasco 
 

 

  

  

  

Bottom row: 
 

 

- Copy the file to another physical destination 
- Search for “orphan” files (files missing or with wrong path) 
- Open the SongList Manager (SongList editor) 
- Replaces the path or file name 
- Create a database report in HTML format 
- Create a database report in Excel format 
- Locate the file on the hard disk 
- Title optimization 

 

  

- ORPHAN FILES (missing files) 

To search for orphan files, click on the button  

 



 

 28

Tip: positioning an icon on a small label will give a brief description 

 

Orphan Files 

 

 

The Orphan File Search feature allows you to scan the entire database looking for files that are 
missing in a way that may have been deleted or moved to another folder.  

To find orphan files, press the "Check" button. Once the scan is complete, you can delete matches 
from the database (Remove All), or show them in the database. The Search function searches for 
all orphan files and once identified, the relative path in the database is automatically updated.  

With New path, on the other hand, the new path is updated manually.  
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YOUTUBE VIDEO SONGS 

WARNING: please accept the conditions of YOUTUBE before using this service 
We remind you that the YOUTUBE service is granted until the next version of WINLIVE is 
released. It will be renewed only when upgrading your Winlive version once delivered. 
 
This function is accessible through the YouTube button located on the other on the left, in 
Performance mode or through View -> YouTube songs or YouTube SongList 
Or press the keys (CTRL + ALT + Y) 

 

As you can see in the image, this function allows you to search and display on the screen the songs 
present directly on YouTube through the search for the title and the artist. 

This function requires an internet connection. 

Within the function, a search filter is already set for the karaoke backing tracks, in addition to the 
display, it is also possible to import them into a SongList of the database and enter the title, artist, 
author, key. 

Attention: It is not possible to modify the song and download the song itself. It is only possible to 
import the link into the database and recall it as if it were any piece of our database. 
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In addition to the search function, it is possible to view a list of songs from Youtube links by simply 
clicking on YouTube SongList (CTRL+ALT+L) 

Once the YouTube file has been launched, it is possible to remove an initial part (for example, to 
skip an unwanted introduction) by right-clicking on Performance and selecting Insert YouTube 
start point, inserting the seconds in order to start the song from the desired point. 
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METRODRUMMER  

With the MetroDrummer you can use a real electronic drum with rhythmic patterns, accessible 
through View -> MetroDrummer or through the MDR button located on the right side of the 
Performance mode (CTRL+ALT+B) 

 

The Metrodrummer can be used independently by reproducing the various rhythms (more than 
220) with classic drum patterns, such as Intro, Standard, Variation and so on. 
Very useful, for example, when you want to perform acoustic pieces with the need for a basic 
rhythmic structure (keys: \ 1 2 3 4 5 6 and 7 for the various drum patterns) 

The MetroDrummer can also be used as an electronic metronome for our classic teaching 
exercises by pressing the METRONOME button 
Furthermore, with MetroDrummer it is possible to synchronize our midifiles with the various 
rhythms, for example to perform a MEDLEY live by playing the various midifiles that we will 
perform at the same rhythm. 
Click on MIDIFILE SYNCRO (key: 9) so that the first midifile and then all the other midifiles that we 
want to play will start with the present rhythm while with STYLE SYNCRO (key: 0) it is the midifile 
that synchronizes the rhythm of the MetroDrummer.
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WINLIVE DJ CONTROL  

Simplified section for DJs, accessible through View -> Winlive DJ control or through the WDJ 
button in Performance mode (keys: CTRL+ALT+J) 

 

Winlive DJ mode with BPM recognition for Audio files with real-time effects, allows you to perform 
both manual and automatic mixes. 

To perform the Automatic mix with the first track in play and the second one booked, just click 
first on Tempo Sync and then on Auto mix, in this way Winlive DJ will automatically switch from 
one track to another. 

In order to mix manually, so with the first track in play and the second one booked, just click first 
on Tempo sync and then on Manual mix. In this case, you will find a writing in red (Mix 2%). Click 
on it to advance the mixing percentage and gradually switch from one track to another. 

In addition to the various ways of mixing, the Winlive DJ also allows you to 
insert effects such as Reverse Play, auto WHA and Phaser that can be used 
through the pad on the right.
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Options 

General Options: 

 
Stop at the end of each song 
Disables automatic reservation of the next song in the list 
 
Stop of the song even if reserved 
Disables automatic song playback even if reserved 
 
Random next song 
Randomly book the next song 
 
Disable automatic song start 
Each song requested does not start automatically but is started with the enter key 
 
Sliding Melody Bar 
The melody bar, which can be called up from the CTRL + E performance, can be fixed in screens or 
sliding 
 
View markers in the Melody bar 
As a description 
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Midi 1 options: 

 

Device Midi 
It is possible to set a device for Midi both physical (Expander, Keyboard) and virtual (Roland VSC, 
Miscrosoft SoftSynth, etc.). 
The Refresh key updates the list if you have just connected a new device. 
 
Use Winlive Synth Engine (WSE) 
This feature allows you to use the digital sound bank of the WINLIVE HOME 11 without being 
bound by external expanders. 
 
Out 
Default output for the output of the Midi stream with the possibility of setting the right or left 
channel of the indicated output 
 
Midi Out + WSE 
Allows you to use the Winlive Synth Engine with a midi out to be selected in midi devices. 
 
… 
It allows you to select another digital sound bank (soundfont .sf2) With X you can reset and 
restore the Winlive sound bank 
 
Start from the First Note 
If checked, it allows you to position yourself directly on the first note useful when opening the 
Midi File, thus allowing immediate access. 
 
Stop on the last NOTE-OFF 
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If checked, it allows you to end the song at the last NOTE-OFF, truncating any tail of the sound. 
Midi tracks Vol% (1-100) 
It allows the variation of the general volume of midi tracks in percentage. 
Midifile compression 
Enables compression of note dynamics of midi files according to the min and max values set 
below. 
 
Midi melody channel 
Defines the midi channel for the melody (as standard set on midi channel 4) 
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Midi 2 options: 
 

 
 
Resolution timer 
Midi messages are sent in bulk every tot milliseconds. Usually 10 milliseconds is the optimal 
resolution. 
An increase in the timer decreases the CPU load but could clog the Midi device, a decrease better 
distributes the midi messages but could weigh on slow CPUs. 
In general, the default working range within which the time is perceptibly precise varies from 5 to 
30 milliseconds. 
 
Midi Engine Multitasking 
The multitasking midi engine allows the execution of multiple midi streams simultaneously, 
increasing the loading and execution speed, excellent for computers with good performance. 
 
Filter Non GM-GS messages 
Leave out the redundant midi events considered useless for the reproduction of Midi files like 
Control Change etc ... 
Some devices with advanced functions such as Karaoke or Vocalist output, in combination with 
some specific songs, may need to send these messages. 
Deselect it only if you encounter such problems. 
 
Light Load 
Leave out some midi events like Pitch-bend, AfterTouch etc ... 
Enable it only if you experience slowdowns in Midi playback. 
 
Notes Partial OFF 
An alternative way to use the pitch change reset, paused and at the end of the song. 
Do not enable it if you use an Expander otherwise the notes will decay very slowly 
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Send Reset Sysex before the song 
Send the Sysex standard reset message before each midi song, the type of reset message (GM, GS 
etc.) can be chosen from the drop-down menu just below. 
Program changes start at 1 
By convention, the displayed program changes can start from 1 instead of 0 (only for visual 
indication) 
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Audio Options: 

 
 
On this screen you can set up to 4 audio outputs and the audio present in the video 
 
Audio Device OUT 1 – OUT 2 It is possible to set a device for the output audio typically a sound 
card. 
And for each output we can decide whether to use it in stereo or mono (left or right) 
The Refresh key updates the list if you have just connected a new device. 
 
Audio Multi-Track vol 
Here the volume for multitrack songs is set 
 
Cut the initial silence 
If checked, it allows the execution of audio files starting directly from the first audible part. It is 
useful to check it if you want immediate execution even for audio tracks, especially CDGs that 
sometimes contain a silent part at the beginning that can last even more than 10 seconds. 
 
Fast loading 
Ability to load on the fly, even faster on audio files. 
The increase in speed is not very evident since Winlive is already very fast in a normal way. We 
recommend that you enable this option only if you really need to play the backing tracks in real-
time as it may reduce the quality of the transpose on some sound cards. 
 
Pre-Load Audio 
If checked, this option allows you to load the audio song into memory at the time of booking, so 
that when it is played the song starts faster. 
 
MultiTask preload 
If checked, this option allows you to speed up the loading of the songs. 
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Time change without distortion 
It allows the change of time without the song distorting. 
 
Compression of volumes 
Enable volume compression on audio, for details go to tools -> Winlive audio options. 
 
Enable Gain 
Enable the use of gain in the virtual mixer. 
 
Audio Buffer 
Set the buffer size. Increase this parameter in case of interruptions when playing audio and video 
files. It is recommended not to decrease from the default value. 
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Karaoke and pictures: 

 
 
From this screen you can change the graphic theme of the program, the background image, 
customize the colours of the text and the background as well as the character of the Karaoke and 
more. 
 
Theme 
Allows you to select a graphic theme for Winlive. 
The theme affects the background and colour of the text, the fill and the shadows or effects. 
 
Use background image 
If checked, it matches by default the background image of the theme for all executions. 
 
Random images from a folder 
It is possible to select a folder from which Winlive loads images randomly and associates them 
with each song. 
 
Custom colours 
Allows customization of colours for text, fill and so on 
By extra line, we mean the extra lines following the running text 
 
Background colour 
In the absence of a background image, it is possible to change the background colour 
 
Font 
It is possible to establish a character common to all the text display modes 
 
Main Karaoke mode 
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I come seven modes and parameters for displaying the text in the main monitor 
It is also possible to improve the graphic quality of karaoke (not recommended for "slow" 
computers) 
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SongList:

 
 
SongList sort type 
It is possible to choose the sorting order for all the SongLists 
ID = insertion order, the last inserted will go to the end 
TITLE = by title, INTERPRETER = by interpreter, AUTHOR = by author, 
GENRE_NOTES = for the genre of the song or for the relative annotations 
TYPE = by type of song (e.g. midi, mp3, video, etc.) 
The sorting order of the SongList can be selected by combining different fields. 
You can use the Order field, which allows you to make a customized sorting of the lists as defined 
in the database. For a specific sorting for each SongList, refer to the SongList editor function in the 
instrument voice. 
 
SongList cells 
Allows you to set the size of the cells. Setting two cells per row gives you the largest dimensions 
for the cells. 
 
SongList columns 
Allows you to set the number of columns to be displayed in the SongList. 
 
Font size / SongList cell 
It allows you to set the font size within the cells of all the SongLists. 
 
Number of characters per cell 
It is used to set the maximum number of characters that each cell must have. 
 
SongList position 
You can view the SongList at the bottom, left or right side 
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Manage interpreter / author / time field etc. 
Interpreter to the right of the title 
It allows you to choose where to place the interpreter of a song. 
 
Typing in SongList 
It allows you to do a smart search, even writing only the first letters of the song.  
 
Grid style 
Allows you to adjust the border of the cells of all the SongLists. 
 
Text style 
Allows you to adjust the evidence of the text within the SongLists. 
 
SongList colours 
It allows the variation of the colours displayed within the SongList, assigning a different colour for 
each type of file, as well as for the background and selection. 
 
Highlight orphaned files in the SongList 
This important function identifies orphan files, i.e. files whose path does not match the one in the 
database. If the files are blackened, it means that they are unplayable.  
 
SongList font 
Allows the adjustment of characters within the SongList. 
 
Chords and Texts: 

 
 
TXT font 
Allows you to change the font, colour and size of the text beyond the background. 
It is also possible to center the TXT text and the RTF text 
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Automatic text scrolling 
When associating a text (txt or rtf) with a file we can decide the scrolling speed of the text. 
Remember that you can use the K and L keys to move forward or backward in the text. 
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CDG / Video (Expert users only) 

 
 
It is good to interact with these parameters only if you are fully aware of the structure and 
characteristics of the Mp3 + CDG (Graphic Karaoke) files. 
 
CDG (expert users) 
Personal background on the CDG 
If enabled, use the current background colour instead of the original background colour in the 
CDG. 
 
Use board on the GDG 
Enable border colouring in the CDG where available. 
Disabling, by default, allows an improvement in the reproduction of CDGs on the computer that do 
not need a border like on a TV. 
 
Bias-Colour 
You can adjust the RGB colour gamut (Red, Green, Blue), higher values result in greater brightness 
for the respective colour gamut. 
 
VIDEO FILES 
Video Engine 
Select the video "engine" to read the files 
 
Audio Delay 
Establishes the audio delay compared to video. It is used when there is no perfect synchrony 
between video and audio 
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OPERATIONS ON THE OPTIONS 
 
• TO APPLY THE OPTIONS IT IS NECESSARY TO CLICK ON "APPLY" 
• TO EXIT THE SCREEN BY LEAVING THE MODIFICATIONS CLICK ON "CANCEL" 
 
With IMPORT you can import configuration options from one computer to another by exporting 
them with EXPORT 
With RESET the "factory" configurations are restored 
USE SETTINGS FOR MINIMUM REQUIREMENTS to set the minimum options compatible with less 
performing computers 
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Extra/Help 

SHORTCUTS 

Here is a list of keys (shortcuts) and related functions:  
 
(Windows) 
 
Spacebar    Opens the SongList or Pause / Play of the Song 
Arrow Keys    Opens the relevant SongList 
F1, F2, ..., F10    Opens the relevant SongList 
Shift + [F1 .. F10]   Opens the relative SongList 
Ctrl + [F1 .. F10]   Opens the relative SongList 
Shift + Ctrl + [1 .. 0]   Opens the relative SongList 
O     Play from the beginning of the song 
Q     Fade Out to the booked Song 
W     Change the size of the Karaoke text (small Med. Grd.) 
Shift + W    Change the text mode in the Main monitor 
Ctrl + W    Change the text mode in the karaoke monitor 
F     Next 
R     Back 
M     Melody (ch. 4) Yes / No [Song Midi] 
T     Restores the original Tempo [Song Midi] 
U     Solo Melody (Ch. 4) [Song Midi] 
N     Channels on / off as originally 
P     Talk Over (on key pressed) 
A     Activate all channels [Song Midi] 
D     Drum only (Ch. 10) [Song Midi] 
C     Show / Hide chords 
Shift + C    Displays / Hides the Chords in the Karaoke Monitor 
Y     Mix with the booked Song 
Shift + Y    Manual Mixing (then press Y) of the booked song 
H     Scrolls through the mixing modes 
X     Opens the mixer 
I                   Opens the Mixer in Instruments mode (you can press the 1..0 and Q 

... Y keys for the On / Off tracks) 
V     Vocalist track (Ch. 16) Yes / No [Song Midi] 
B     Bass only (Ch. 2) and Drums (Ch. 10) [Song Midi] 
Enter    Send Play of the booked Song 
Pause     Pause / Play 
+     Increase by a semitone 
-     Decrease of a semitone 

Pg. Up     Tempo increase [Song Midi] 
Pg. Down    Tempo decrease [Song Midi] 
Ctrl + +    Increase a Semitone of the booked song 
Ctrl + -    Decrement of a Semitone of the Booked song 
Ctrl + Pg. Up    Tempo increase of the booked song [Midi and Audio] 
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Ctrl + Pg. Down   Tempo Decrement of the booked Song [Midi and Audio] 
Ctrl + M    Melody (Ch. 4) of the booked song Yes / No [Song Midi] 
End     Stop the booked song (STOP) 
Z     Fullscreen mode 
Backspace    Opens the song search window in the SongList 
Tab     Scrolls between occurrences of searches in the SongList 
S     Audio Sampler 
E    Show / Hide the Melody Bar 
Ctrl + Q / Ctrl + S   Virtual save current song 
Ctrl + K    Enable / Disable the Karaoke Monitor 
Ctrl + J    Enable / Disable the Clone Monitor 
,     Enable / Disable Drum Part Off midi drums 
.     Enable / Disable Drum Part Off midi percussion effects 
Shift + M    Enable / Disable any second associated track 
Shift + Pg. Up    Increase the Song Volume 
Shift + Pg. Down   Decreases the Song Volume 
Shift + [F11]    Open the whole database 
Home    Open Song List 
Del     Only if in loop Markers: Exit the loop 
Y     Only if it is Groove (midi or audio) does it exit the groove at the end 
 
Performance Display (With the SongList open): 
Home / Home   First column of the SongList 
End     Last column of the SongList 
Initial     Search for the first song with the initial 
Space     Book the Song and close the SongList 
Ins     Insert the Song into the Temporary Song List (F10) 
Pg. Up     First line of the SongList 
Pg. Down    Last line of the SongList 
Backspace    Search for a Song 
Tab     Repeat search 
Enter / Return  Play of the Song and close the SongList 
Esc     Close the SongList 
Del    Only in F10: delete from the F10 list 
 
 
 
 
 
Audio Sampler 
\     Stop on all samplers 
S     Opens / closes and stops all samplers 
1..2..3 ..... 0    Play of the Sample 
CTRL + 1..2..3 ..... 0   Select the set 
 
Open search 
TAB    Search Song in the current SongList 
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In Database 
Ctrl + K    Enable / Disable the Karaoke Monitor 
ENTER    Send Play of the Song 
Esc     Stop of the Song 
E     Edit the database cell 
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(Mac Osx) 
Performance view (with the SongList closed): 
 
Spacebar    Opens the SongList or Pause / Play of the Song 
Arrow Keys    Opens the relevant SongList 
O     Play from the beginning of the song 
Q     Fade Out to the booked Song 
W     Change the size of the Karaoke text (small Med. Grd.) 
Shift + W    Change the text mode in the Main monitor 
Ctrl + W    Change the text mode in the karaoke monitor 
F     Next 
R     Back 
M     Melody (ch. 4) Yes / No [Song Midi] 
T     Restores the original Tempo [Song Midi] 
U     Solo Melody (Ch. 4) [Song Midi] 
N     Channels on / off as originally 
P     Talk Over (on key pressed) 
A     Activate all channels [Song Midi] 
D     Drum only (Ch. 10) [Song Midi] 
C     Show / Hide chords 
Shift + C    Displays / Hides the Chords in the Karaoke Monitor 
Y     Mix with the booked Song 
Shift + Y    Manual Mixing (then press Y) of the booked song 
H     Scrolls through the mixing modes 
X     Opens the mixer 
I                   Opens the Mixer in Instruments mode (you can press the 1..0 and Q 

... Y keys for the On / Off tracks) 
V     Vocalist track (Ch. 16) Yes / No [Song Midi] 
B     Bass only (Ch. 2) and Drums (Ch. 10) [Song Midi] 
Enter    Send Play of the booked Song 
Pause     Pause / Play 
+     Increase by a semitone 
-     Decrease of a semitone 

Pg. Up     Tempo increase [Song Midi] 
Pg. Down    Tempo decrease [Song Midi] 
End     Stop the booked song (STOP) 
Z     Fullscreen mode 
Backspace    Opens the song search window in the SongList 
Tab     Scrolls between occurrences of searches in the SongList 
S     Audio Sampler 
J     Pre Listening 
E    Show / Hide the Melody Bar 
Ctrl + Q / Ctrl + S   Virtual save current song 
Ctrl + K    Enable / Disable the Karaoke Monitor 
Ctrl + J    Enable / Disable the Clone Monitor 
Shift + Pg. Down   Decreases the Song Volume 
Shift + [F11]    Open the whole database 
Home    Open Song List 
Del     Only if in loop Markers: Exit the loop 
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Y     Only if it is Groove (midi or audio) does it exit the groove at the end 
 

 
 

Performance Display (With the SongList open): 
Home / Home   First column of the SongList 
End     Last column of the SongList 
Initial     Search for the first song with the initial 
Space     Book the Song and close the SongList 
Ins     Insert the Song into the Temporary Song List (F10) 
Pg. Up     First line of the SongList 
Pg. Down    Last line of the SongList 
Backspace    Search for a Song 
Tab     Repeat search 
Enter / Return  Play of the Song and close the SongList 
Esc     Close the SongList 
Del    Only in F10: delete from the F10 list 
 

 
 
 
 
 

Audio Sampler 
\     Stop on all samplers 
S     Opens / closes and stops all samplers 
1..2..3 ..... 0    Play of the Sample 
CTRL + 1..2..3 ..... 0   Select the set 
 
Open search 
TAB    Search Song in the current SongList 
In Database 
Ctrl + K    Enable / Disable the Karaoke Monitor 
ENER    Send Play of the Song 
Esc     Stop of the Song 
E     Edit the database cell 

 

Tips: 
1) Winlive is structured to manage many functions while performing in a show or concert, through 
the exclusive use of the computer keyboard thus avoiding the inconvenience of having to manage 
the functions with the use of the mouse, which implies longer time. 
2) It is advisable to keep a printout of the hot keys on hand, generally after a couple of 
performances in order to memorize the keys and managing the program in a more immediate 
way. 
 
VIDEO TUTORIAL 
We can connect with the latest video tutorial available on Youtube 
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MOBILE SOFTWARE (iOS/Android) 
List of APPs for smartphones and tablets produced by Promusicsoftware. They are available for 
both iOS and Android 
 
WINLIVE ON FACEBOOK 
The official Facebook page of Promusicsoftware 

 

Demo Songs 

DEMO SONGS 
A songlist with various demo backing tracks 
 
BACKING TRACKS 
Links to major backing track producers 
 



 

 53

  

ADDENDUM 

Specifications and compatibility 

Funzione Caratteristica 

File compatibility: 
midi, kar, mp3, wav, wmt, cdg, cdg-zip, avi, mpg, mp4, flv, 
wma, lrc, txt, rtf, jpg, gif, bmp, ytb YouTube, pdf 

Midi format compatibility: Tipo 0, Tipo1, Smf 16 tracce 

Lyrics compatibility: 
Tune1000, M-live, Solton, TextInKar, MP3TagV2, MP3 M-
liveText 

Reset mode: GS, ensures full compatibility with most midi songs 

Maximum number of songs in the list: 120.000 

Maximum song number in database:  > 200.000 

Average song access time: 0.05 - 0.2 sec. calculated on 2Gzh, 2GB ram 

Number of pre-set sounds: 344 Instruments * + 32 DrumKit * + 32 User Sounds 

 

The midi engine has been redesigned from scratch compared to all previous versions of Winlive, 
therefore slight differences in reproduction may be noticed. 

Now the management of the midi takes place totally in MultiTasking, an independent process 
whereby it is now possible to open windows and programs while working on it, reducing Winlive 
to an icon even during the execution of a Midi File, without incurring in slowdowns. 

* There are a lot of usable midi sounds but, by convention, only the name of the first bank 
displayed on the program (e.g. for Hard FM Piano bank024-pc: 006 the name ELECTRIC PIANO 2 
bank will be displayed: 000- pc006). If the device is enabled to reproduce this sound, it will use the 
correct sound.
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LEGAL NOTICES 

WINLIVE HOME user license 
 
READ THIS DOCUMENT CAREFULLY BEFORE INSTALLING THE PROGRAM. 
THE PROGRAM INCLUDED IN THIS DISC IS LICENSED TO THE USER. YOU AGREE TO COMPLY WITH THE 
TERMS OF THIS LICENSE OF USE. WARNING: THIS PROGRAM IS PROTECTED BY COPYRIGHT LAWS AND 
INTERNATIONAL TREATIES. THE SOFTWARE PRODUCT IS LICENSED, IT IS NOT SOLD. UNAUTHORIZED 
REPRODUCTION OR DISTRIBUTION OF THIS PROGRAM, OR PART OF ITS, MAY RESULT IN SEVERE CRIMINAL 
AND CIVIL PENALTIES. 
 
1 - User rights 
PRO MUSIC SOFTWARE grants the end user the right to use a copy of the attached Software program on a 
single computer. The Software is intended "in use" on a computer when it is loaded on the temporary 
memory (RAM) or installed on the permanent memory (eg hard disk, CDROM or other storage medium) of 
that computer. 
 
2 - Copyright 
The software is owned by the PRO MUSIC SOFTWARE and is protected by copyright laws in force in Italy; by 
international provisions and treaties and by all other applicable national laws. In any case, the user cannot 
reproduce the manual or part of it and the written material accompanying the Software. 
 
3 - Warranty limits 
PRO MUSIC SOFTWARE warrants that the Software will function in substantial compliance with the manual. 
To protect the user, it will be possible to use a maximum of 3 activations in total. We remind you that even 
in case of formatting a new activation will have to be used. For further activations please contact 
Promusicsoftware 
 
4 - Limits of liability 
In no case can PRO MUSIC SOFTWARE be held liable for damages (including without limitation: damage due 
to loss or loss of earnings, business interruption, loss of information, penalties or other economic losses) 
deriving from the use or inability to do use of the Software, even if the PRO MUSIC SOFTWARE has been 
warned of the possibility of such damages. 
 
5 - Installation 
WINLIVE HOME uses a self-installing installation package. 
At the time of installation, it will be possible to choose the installation path and other parameters. Note 
that registry entries and system settings may be changed to allow the correct functioning of the program 
itself. 
 
6 - Other restrictions 
The Setup in this Pro version is redistributable as it is. It is forbidden to reproduce even partial and the 
partial distribution of the individual files generated by the Setup. 120 minutes of FREE REMOTE ASSISTANCE 
and YOUTUBE SERVICE until February 2022 are guaranteed.
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Credits and Thanks 
A special thanks is due to all BetaTesters as well as those who have worked on our Forum in order 
to make the program more and more in line with current standards, providing ideas and advice to 
make the program more efficient and pleasant. 
 
Ideator: Leonardo Di Pinto 
Author and programmer: Pinto Giuseppe Massimo 
Programmer consultant: Leonardo Cosmai 
Technical consultant: Leonardo Di Pinto 
Graphics: Monti Francesco 
Supervisor: Di Pinto Lucrezia (Lulu) 
Contributors: Mary Chiaro, Di Pinto Girolamo (Gigi), Di Pinto Mariachiara, Acquafredda Francesco 
External consultants: Vizzini Damiano, Kevin Lindop, Zen Massimo, Alberto Fontana, Dimarti Eber, 
Vernucci Massimo, De Iudicibus Mauro, Alex Ciccio Viola, Di San Leonardo Gaetano, Luca La Paglia 
 

Made by ProMusicSoftware 

 
www.promusicsoftware.com 
info@promusicsoftware.com 

PROMUSICSOFTWARE -  Bisceglie (BT) - Italy 

 
This guide generally follows the version of WINLIVE HOME / HOME SYNTH 11, we are not 
responsible for any omissions or inconsistencies as micro-updates released frequently may vary 
product specifications. 

 


